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EC Declaration of Conformity 

 
Manufacturer: EDAN Instruments, Inc. 

Addr: 3/F-B, Nanshan Medical Equipments Park, Nanhai Rd 1019#, Shekou, Nanshan 
Shenzhen, 518067 P.R. CHINA 

European Representative:Shanghai International Holding Corp. GmbH (Europe) 

Addr: Eiffestrasse 80 D-20537 Hamburg Germany 

Product: Ultrasonic Pocket Doppler 

Model: SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, 
SONOTRAX II, SONOTRAX II Pro 

Classification (MDD, Annex IX): IIa  

 

We herewith declare that the above mentioned product(s) meet the transposition into national 
law, the provisions of Council Directive 93/42/EEC of 14 June 1993 concerning medical 
devices - as amended by Directive 98/79/EC on in vitro diagnostic medical devices. 

All supporting documentation is retained at the premises of the manufacturer. 
 

DIRECTIVES 
General Applicable Directives: 

Medical Device Directive: COUNCIL DIRECTIVE 93/42/EEC of 14 June 1993 concerning 
medical devices (MDD 93/42/EEC). 

 
Standards applied: EN ISO 9001, ISO13485, EN ISO14971, EN ISO10993-1, IEC 601-1, EN 
60601-1-1, BS EN 60601-1-4, IEC 60601-1-2, EN 61157, EN 1041, EN 60417-2-2000, 
IEC/TR 60878-2003, EN 980, EN 55011, ISO 1000, YY 0111-93, EN 61266, EN ISO 780 , 
GB/T 14740, GB/T 15464 

Notified Body: TÜV SÜD Product Service GmbH, Ridlerstr 65, D-80339 MÜnchen, Germany. 

Identification number    
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Copyright 
© Copyright Edan Instruments, Inc. 2007. All rights reserved. 

Attention 
Edan Instruments, Inc. (hereinafter called EDAN) makes no warranty of any kind with regard 
to this material, including, but not limited to the implied warranties of merchantability and 
fitness for a particular purpose. EDAN assumes no responsibility for any error that may 
appear in this document, or for incidental or consequential damage in connection with the 
furnishing, performance or use of this material. 
No part of this document may be photocopied, reproduced or translated to another language 
without prior written consent of EDAN. 
The information contained in this document is subject to change without notice. 

Responsibility of the Manufacturer 
EDAN only considers itself responsible for any effect on safety, reliability and performance 
of the equipment if: 
Assembly operations, repairs are carried out by persons authorized by EDAN, and the device 
is used in accordance with the instructions for use. 

WARNING : This device is not intended for treatment. The intended use is 
for clinical use. If the FHR result is distrustful, please use 
other methods such as stethoscope to verify immediately. 

Using This Label Guide 
This guide is designed to give key concepts on safety precautions. 

WARNING  

A WARNING label advises against certain actions or situations that could result in personal 
injury or death. 

CAUTION  

A CAUTION label advises against actions or situations that could damage equipment, 
produce inaccurate data, or invalidate a procedure. 

NOTE: A NOTE provides useful information regarding a function or a procedure. 
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Chapter 1 Safety Guidance 

This unit is internally powered equipment, and the degree of shock protection is type B. 

       
Type B protection means that these person connections will comply with permitted leakage 
currents, dielectric strengths of IEC 60601-1. 

1.1 Safety Precautions 

WARNING and CAUTION messages must be observed. To avoid the possibility of injury, 
observe the following precautions during the operation of the device. 

WARNING : This device is not explosion-proof and can not be used in the 
presence of flammable anaesthetics.  

WARNING : Do not throw batteries in fire as this may cause them to explode. 

WARNING : Do not attempt to charge normal alkaline batteries, they may leak, 
and may cause a fire or even explode. 

WARNING : Charge the lithium-ion polymer battery with the special charger 
supplied by EDAN. 

WARNING : Don’t touch signal input or output connector and the person 
simultaneously. 

WARNING : Accessory equipment connected to the analog and digital interfaces 
must be certified according to the respective IEC standards (e.g. 
IEC 950 for data processing equipment and IEC 60601-1 for 
medical equipment). Furthermore all configurations shall comply 
with the valid version of the system standard IEC 60601-1-1. 
Everybody who connects additional equipment to the signal input 
connector or signal output connector configures a medical system, 
and is therefore responsible that the system complies with the 
requirements of the valid version of the system standard IEC 
60601-1-1. If in doubt, consult our technical service department or 
your local distributor. 

WARNING : SONOTRAX Series Ultrasonic Pocket Doppler is a tool to aid the 
healthcare professional and should not be used in place of normal 
fetal monitoring. 

WARNING : We recommend that exposure to ultrasound should be kept as low 
as reasonably achievable. This is considered to be good practice 
and should be observed at all time. 

WARNING : Replacing battery shall only be done outside the personnel 
environment (1.5m away from the personnel).  

WARNING : Please use probes provided by EDAN.  
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WARNING : The stretching length of probe cable should be less than 2m in 
order to avoid the cable breaking away from the probe socket. 

CAUTION : Federal law restricts this device to be used by or on the order of a 
physician. 

CAUTION : Refer servicing to qualified personnel. 

CAUTION : The main unit of the SONOTRAX Series is designed for continuous 
operation and is ‘ordinary’. Do not immerse in any liquid (i.e. not 
drip or splash-proof).  

CAUTION : Keep the device clean. Avoid vibration.  

CAUTION : Do not use high temperature sterilizing process and E-beam or 
gamma radiation sterilization. 

CAUTION : Electromagnetic Interference-Ensure that the environment in 
which the device is operated is not subject to any source of strong 
electromagnetic interference, such as radio transmitters, mobile 
telephones, etc. Keep them far away. 

CAUTION : The user must check that the equipment does not have visible 
evidence of damage that may affect personnel’s safety or 
monitoring capability before use. The recommended inspection 
interval is once per month or less. If damage is evident, 
replacement is recommended before use. 

CAUTION : The following safety checks should be performed once every two 
years or as specified in the institution’s test and inspection protocol 
by a qualified person who has adequate training, knowledge, and 
practical experience to perform these tests. 
Z Inspect the equipment for mechanical and functional damage. 
Z Inspect the safety relevant labels for legibility. 
Z Verify that the device functions properly as described in the 

instructions for use. 
Z Test the the pregnant woman’s leakage current according to 

IEC 60601-1/1988: Limit: 100 uA (B). 
The leakage current should never exceed the limit. The data should 
be recorded in an equipment log. If the device is not functioning 
properly or fails any of the above tests, the device has to be 
repaired. 

CAUTION :  If the rechargeable buttony battery is used, please charge it fully 
before use in order to protect its performance and life. Under 
normal temperature, the battery should be charged for 14 hours 
continuously at standard charge circuit. 

CAUTION : The battery must be taken out from the battery compartment if the 
device will not be used for a long time.   
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CAUTION : The device shall only be used if the battery cover is closed. 

CAUTION : The battery must be proper disposed according to local regulation 
after their use. 

CAUTION : The device could be sent back to the manufacturer for recycling or 
proper disposal after their useful lives. 

1.2 Symbols  

 
This item is compliant with Medical Device Directive 93/42/EEC of 14 June 1993, a directive 
of the European Economic Community. 

: Attention. Refer to accompanying documents. 

 This symbol consisting of two parts, see below. 

 
It indicates that the equipment should be sent to the special agencies according to local 
regulation for separate collection after its useful life. 

 
It indicates that the equipment is put on the market after 13 August 2005. 
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Chapter 2 Introduction 

2.1 Overview 
SONOTRAX Series Ultrasonic Pocket Doppler is an advanced obstetrical unit, which can 
meet routine examination requirements of obstetricians. They can also used for vascular 
monitoring (optional). 

There are six different models available: SONOTRAX Lite, SONOTRAX Basic, 
SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and SONOTRAX II Pro. 
SONOTRAX Lite is for simple auscultation (intermittent listening). SONOTRAX Basic, 
SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and SONOTRAX II Pro are not 
only used to listen in the fetal heart, they also display the fetal heart rate on a LCD screen. 

2.2 Features 

Different model has different feature, refer to the chart below for details: 

 
      Function 

Model 
SONOTRAX 

Lite 
SONOTRAX 

Basic 
SONOTRAX 
Basic A 

SONOTRAX 
Pro 

SONOTRAX 
II 

SONOTRAX 
II Pro 

LCD Display  √ √ √ √ √ 

LCD Backlight   √ √ √ √ 

Mini USB Probe 
Socket √ √ √ √ √ √ 

Probe Detecting √ √ √ √ √ √ 

Probe Identifying  √ √ √ √ √ 

Built-in Speaker √ √ √ √ √ √ 

Attached Earphone √ √ √ √ √ √ 

Volume Adjustable √ √ √ √ √ √ 

Modes Switching  √ √ √ √ √ 

Audio Recording and 
Playing    √  √ 

Alkaline Battery (9V) √ √ √ √   

Lithium-ion Polymer 
Battery     √ √ 

Charge in Machine     √ √ 
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Low Battery 
Detecting √ √ √ √ √ √ 

Low Battery 
Indicating √ √ √ √ √ √ 

Auto Shutdown  √ √ √ √ √ 

Vascular Monitoring √ √ √ √ √ √ 

2.3 Ordering Information 

The accessories for normal use supplied or approved by EDAN can be used with 
SONOTRAX Series Ultrasonic Pocket Doppler. 

Accessory  Manufacturer and Part Number 

Coupling Gel (0.06litre/0.25litre bottle) Parker Aquasonic 100 or equivalent, MS2-14019 

2.0MHz Waterproof Probe EDAN, MS3-14320 

3.0MHz Waterproof Probe EDAN, MS3-14321 

4.0MHz Waterproof Vascular Probe EDAN, MS3-14346 

8.0MHz Waterproof Vascular Probe EDAN, MS3-14347 

Alkaline Battery (9V) NANFU, M21-64048 

Lithium-ion Polymer Battery (900mAh) Xwoda Electronics Co. Ltd, M21R-64083 

Lithium-ion Polymer Battery (500mAh) HYENERGY, M21R-64084 

Line-in Cable EDAN, M13-36032 

Lithium-ion Polymer Battery Charger HYENERGY, M21R-64082 

Earphone EDAN, M13-36041 

Carry Bag EDAN, MS1-14268 
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Chapter 3 Doppler and Accessories 

3.1 Appearance 

Take example for 2.0MHz waterproof probe. 

Figure 3-1 Front Panel                         Figure 3-2 Rear Panel    

 

   

 

Figure 3-3 Top Panel                            Figure 3-4 Left Panel 
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3.2 Display Panel 

There is a LED at the left-bottom corner of the display panel area of SONOTRAX Lite. When 
powered on, the LED turns into green. If the green LED flashes, it indicates that the probe is 
disconnected or bad connected. If the LED turns into orange and flashes, it indicates that the 
battery is too low to support working. Change for a new battery or charge the chargeable 
battery in time. 

For SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and 
SONOTRAX II Pro Ultrasonic Pocket Doppler, while self-testing, the LCD display is as 
follows: 

Figure 3-5 LCD display status while self-testing 

 
 

Working Mode:  

Here shows which working mode is the Doppler working on. 

FHR Refresh Frequency:  

When monitor starts, the heart shape flashes, its frequency indicates the FHR refreshing 
frequency. 

Battery Indicator:  

For SONOTRAX Basic, a battery symbol appears on the LCD after powered on, when 
battery is low, this symbol flashes; the Doppler will shut down automatically after 7 seconds.  

For SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and SONOTRAX II Pro, there 
are several green panes in the battery symbol on the LCD, which indicates the battery electric 
energy. The green panes disappear gradually with the energy consumption. When battery is 
low, the empty symbol flashes for 3 times then the Doppler shuts down automatically. 

PLAYING: 

PLAYING is highlighted when the Doppler is playing the recorded audio signals. 

RECORDING: 

RECORDING is highlighted when the Doppler is recording. 

FHR Refresh 
Frequency 

Battery Indicator 
 

Recording 
 
FHR Display 
 

Probe Type 
 

Playing Communication, Reserved 
Working Mode 
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FHR Displaying: 

Here displays the fetal heart rate value, whose unit is bpm (beat per minute). 

Probe Type: 

The Doppler can detect and identify the probe: when the probe is not connected or not well 
connected to the Doppler, the “---” symbol and “MHz” symbol on the LCD screen flash; 
when the probe is well connected, the flashing stops, the probe type displays on the LCD 
screen. 

Communication 

The Doppler can communicate with PC. This function is reserved. 

3.3 Buttons 

At most there are four push buttons (Power, MODE, START/STOP and REC/PLAY) and a 
volume control button on the SONOTRAX Series Ultrasonic Pocket Doppler. Their primary 
functions are as follows: 

(1) Power Button  

Function: Switch on or off the Doppler. 

(2) MODE Button  

 (Only for SONOTRAX Basic / SONOTRAX Basic A/ SONOTRAX Pro/ SONOTRAX II/ 
SONOTRAX II Pro) 

Function: Select the working mode.  

(3) START/STOP Button  

(Only for SONOTRAX Basic/ SONOTRAX Basic A/ SONOTRAX Pro/ SONOTRAX II/ 
SONOTRAX II Pro) 

Function: Start/ stop monitoring (Mode 3)/ setting (Mode 4 and Mode 5). 

(4) REC/PLAY   

(Only for SONOTRAX Pro/ SONOTRAX II Pro) 

Function: Start/ stop recording or playing. 

(5) Volume Control Indicator  

Function: Adjust volume. Rotate the volume gear clockwise to turn up the volume, while 
rotate it anti-clockwise to turn down the volume. 
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3.4 Socket 

The two sockets are located on the top panel of the Doppler. 

(1) Earphone socket : the earphone or line-in cable connects to the Doppler via this 
socket. 

Figure 3-6 Line-in Cable 

 

   : Attention. Refer to the accompanying documents. 

Signal Interface 

                 1    GND      2 Signal 

               3    Signal     4 Signal 

               5    Signal 

(2) Charge socket : the special lithium-ion polymer battery charger connects to the 
Doppler via this socket. (For SONOTRAX II and SONOTRAX II 
Pro only) 

NOTE: Accessory equipment connected to the analog and digital interfaces 
must be certified according to the respective IEC standards (e.g. IEC 
950 for data processing equipment and IEC 60601-1 for medical 
equipment). Furthermore all configurations shall comply with the valid 
version of the system standard IEC 60601-1-1. Everybody who connects 
additional equipment to the signal input connector or signal output 
connector configures a medical system, and is therefore responsible 
that the system complies with the requirements of the valid version of 
the system standard IEC 60601-1-1. If in doubt, consult our technical 
service department or your local distributor. 

2

1 

3 
4 

5 
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3.5 Probes 

3.5.1 Waterproof Probes 
2.0MHz/3.0MHz waterproof probe can be connected with the main unit of the SONOTRAX 
Series. 

Figure 3-7  2.0MHz waterproof probe     Figure 3-8  3.0MHz waterproof probe 

             
The main information on the probe is as follows: 

CD2.0/3.0: CD means continuous wave Doppler, 2.0/3.0 means central frequency is 2.0 
MHz/3.0MHz. 
MS3-14320: Part number of the 2.0MHz waterproof probe. 
MS3-14321: Part number of the 3.0MHz waterproof probe. 
A: Version number of the probe.  
SNxxxxx: Serial number of the probe. 
Waterproof: The probe is waterproof. 
IPX8: Water Ingress Protection Code, which indicates this probe can work continuously for 5 
hours when being immersed into water within 1 meter depth. 

3.5.2 Waterproof Vascular Probes 

The 4.0MHz (optional) and the 8.0MHz waterproof vascular probes are used for monitoring 
arteries and veins.  

Figure 3-9  4.0MHz Waterproof Vascular Probes       Figure 3-10  8.0MHz Waterproof Vascular Probes 
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The main information on the probe is as follows. 
CD 4.0/CD8.0: CD means continuous wave Doppler, 4.0/8.0 means the central frequency is 
4.0/8.0 MHz. 

MS3-14346: EDAN part number of 4.0MHz waterproof vascular probe. 

MS3-14347: EDAN part number of 8.0MHz waterproof vascular probe. 

A: the version number of this vascular probe. 

SNxxxxx: Serial number of this vascular probe. 

Waterproof: The probe is waterproof. 

IPX8: Water Ingress Protection Code, which indicates this probe can work continuously for 5 
hours when being immersed into water within 1 meter depth. 

 

3.5.3 Probe Socket 
 Figure 3-11 Probe socket  

 
The probe socket is shown as Figure 3-11.  

Connect the 2.0MHz waterproof probe, 3.0MHz waterproof probe, 4.0MHz waterproof 
vascular probe or 8.0MHz waterproof vascular probe developed by EDAN to the 
SONOTRAX Series according to real requirements.  

WARNING : Do not try to connect any other plug to the probe socket 
except the plug of the probes mentioned above.  

WARNING : In case of disengaging from the probe interface, the 
connecting cable of the probe can not be dragged for more 
than 2 meters. 

Jack Definition 
1 Power Supply 
2 Signal 
3 Probe Coding 1 
4 Probe Coding 2 
5 Probe Coding 3 
6 (Shell) GND 
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3.6 Battery 

Power of the SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A and 
SONOTRAX Pro Doppler comes from a 9V alkaline battery (IEC Type No. 6LR61/6LF22 or 
equivalent). 

Power of the SONOTRAX II and SONOTRAX II Pro Doppler comes from a lithium-ion 
polymer battery supplied by EDAN.  
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Chapter 4 Operation 

NOTE: To ensure that the Doppler would work properly, please read this chapter and 
Chapter 1 Safety Guidance before operating; follow the steps when 
connecting all the components. 

4.1 Opening the Package and Checking 

Open the package; take out the Doppler and accessories carefully. Keep the package for 
possible future transportation or storage. Check the components according to the packing list. 
Z Check for any mechanical damage. 
Z Check all the cables and accessories. 
If there is any problem, contact us or your local distributor immediately. 

4.2 Installing Battery 

1. Open the battery compartment. 

   Turn the rear panel up. Press the top stripe symbols of the compartment cover hard with 
one thumb. Meanwhile slide the cover out along the direction of arrowhead with the other 
thumb (figure 4-1). 

   Figure 4-1 Remove the compartment cover 

   
 

2. Place the battery. 

For SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A and SONOTRAX Pro 
Doppler, there is a battery connector that has been inserted to the battery socket in the 
compartment. Take out a new battery and connect the battery to the connector; put the 
assembly back into the compartment with the connector inward.  

Battery socket 

Battery connector 
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For SONOTRAX II and SONOTRAX II Pro Doppler, insert the plug of the lithium-ion 
polymer battery into the battery socket and put them into the compartment with the wires 
inward. 

3. Slide the compartment cover back to close the compartment. 

 

CAUTION : Take out the battery and keep it in cool and dry environment if the 
Doppler will not be used for a long time.  

CAUTION : For the lithium-ion polymer battery, charge it in the machine with the 
special charge when its power is low. Do not charge it with other 
charges or remove it frequently. 

4.3 Probe Operation 

(1) Taking out Probe  

Hold the Doppler main unit with one hand, and hold the top of the probe with another hand 
(Figure 4-2). First take out the top of the probe (Figure 4-3). Then take out the whole probe 
from the probe frame (Figure 4-4). 

(2) Placing Probe 

Follow the opposite steps to take out the probe. 

Hold the main unit with one hand, and hold the top of the probe with another hand (Figure 
4-4). Place the probe from the middle of the unit (at the right) into the probe holder (Figure 
4-3), then push the top of the probe (Figure 4-2). 

Figure 4-2                     Figure 4-3                    Figure 4-4 

               

(3) Removing and Connecting a Probe 
One probe has been connected to SONOTRAX Series ultrasonic pocket Doppler while 
packed by the manufacturer. If the user needs to replace it with another probe, take out the 
probe first; then pull out the plug of the probe from its socket (figure 4-5). Connect the plug 
of another probe to the socket and then the probe can be used. 



SONOTRAX Series Ultrasonic Pocket Doppler User Manual 

- 15 - 

Figure 4-5 Remove the Probe 

 

NOTE: Place the temporarily unused probe carefully and avoid falling off, 
splash or stress, etc. When the Doppler is not used for a long time, it’s 
recommended to connect the probe to the Doppler and keep them 
safely in the package. 

4.4 Turn on the Doppler 

Press the POWER button on front panel to turn on the Doppler. 

4.5 Modes Setting 

SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II and 
SONOTRAX II Pro Dopplers have a number of mode options. Press the MODE button to 
switch to the next mode. 

If the SONOTRAX Basic/ SONOTRAX Basic A/ SONOTRAX Pro/ SONOTRAX II/ 
SONOTRAX II Pro Doppler worked on Mode1/ Mode 2/ Mode 3 last time before shutdown, 
after self-testing, the Doppler will enter the same mode automatically. If its last mode is Mode 
4/ Mode 5, it will enter Mode 1 after self-testing. 

4.5.1 Real-time FHR Display Mode (Mode 1) 

When the Doppler works on this mode, the Working Mode on LCD displays 1. 

As soon as a fetal heart signal is detected, the heart shape on LCD flashes, the FHR display 
area displays the real-time FHR value. 

4.5.2 Averaged FHR Display Mode (Mode 2) 

When the Doppler works on this mode, the Working Mode on LCD displays 2. 

The heart shape on LCD flashes when fetal heart signal is detected, the FHR value indicates 
the average value of 8 beats, which changes slowly. 
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4.5.3 Manual Mode (Mode 3) 

When the Doppler works on this mode, the Working Mode on LCD displays 3. 

Press START/STOP button once and immediately start counting, count 1 on the moment 
when the button is pressed. The LCD displays the flashing heart shape symbol and “---”. Press 
the button again on the 10th count (after 9 beat intervals). 

The Doppler automatically calculates the derived FHR averaged over the 10 beat periods and 
displays the result. This rate value will not disappear until another measurement starts or the 
mode is changed. 

4.5.4 Back Light Brightness Setting Mode (Mode 4) 
This mode is only for SONOTRAX Basic A/ SONOTRAX Pro/ SONOTRAX II/ 
SONOTRAX II Pro. 

When the Doppler works on this mode, the Working Mode on LCD displays 4. 

Press START/STOP button to set the brightness of white back light. “OFF” displayed at the 
LCD means the white back light is disabled, while “ON” means the white back light is 
enabled. 

NOTE: The setting under this mode will be saved automatically after mode 
switching or normal power off. 

4.5.5 Record Sampling Frequency Setting Mode (Mode 5) 
SONOTRAX Pro/ SONOTRAX II Pro Doppler have the build-in function of recording and 
playing audio signals, this mode is used to set the record sampling frequency. 

When the Doppler works on this mode, the Working Mode on LCD displays 5. 

Press START/STOP button, the sampling frequency switches between 4 and 8 on the LCD. 
“4” means the frequency is 4KHz, the longest record time is 480 seconds; while “8” means 
8KHz, the longest record time is 240 seconds. 

NOTE: (1) The setting under this mode will be saved automatically after mode 
switches or normal power off.  

(2) After changing frequency, the records related to the original 
frequency will be cleared automatically.  

4.6 Fetal Heart (FH) Monitoring 

FH monitoring with 2.0MHz waterproof probe or 3.0MHz waterproof probe 

Feel the position of the fetus by hand firstly to find out the best direction to the fetal heart. 
Apply a liberal amount of gel to the faceplate of probe; place the faceplate of probe at the best 
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position for detecting fetal heart. Adjust the probe to obtain an optimum audio signal ideally 
by angling the probe around. Adjust the volume according to requirements. Refer to figure 
4-6. 

Figure 4-6 FH monitoring 

 

The audio fetal heart beat is sent out via the built-in speaker or attached earphone; the FHR 
value is displayed on the LCD (except SONOTRAX Lite). 

NOTES: 

1) The best quality records will only be obtained if the probe is placed in the 
optimum position. 

2) Positions with strong placental sounds (swishing) or fetal cord pulse 
(indistinct pulse at fetal rate) should be avoided. 

3) If the fetus is in the cephalic position and the mother is supine, the clearest 
heart sound will normally be found on the midline below the umbilicus. 
During monitoring prolonged lying in the supine position should be avoided 
owing to the possibility of supine hypotension. Sitting up or lateral 
positions are preferable and may be more comfortable to the mother. 

4) It is not possible to FHR unless an audible fetal heart signal is present. The 
fetal pulse can be distinguished from the maternal pulse by feeling the 
mother’s pulse during the examination. 

4.7 Build-in Recording and Playing 

This function is only for SONOTRAX Pro/ SONOTRAX II Pro. 

Recording: Press the REC/PLAY button and hold for 3 seconds under mode 1, 2 or 3, the 
machine starts recording, “RECORDING” will appear on the LCD. The longest record time 
depends on the recording sampling frequency set in mode 5. The machine records 480 
seconds with 4KHz frequency and 240 seconds signal with 8KHz frequency. 
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The machine will stop recording and return to monitoring status when the limited time is over 
or when the user presses the REC/PLAY button again.  

Playing: Press the REC/PLAY button under mode 1, 2 or 3 when the machine is not 
recording, “PLAYING” will appear on the LCD, the machine plays the recorded signals. 
When playing is over or the user presses the REC/PLAY button again it will return to the 
monitoring status. 

4.8 Record Fetal Heart Sounds 

The fetal heart sound signal can be transferred to a personal computer (PC) and recorded by 
its Sound Recorder. You can play the recorded sound files, burn them into CDs or e-mail 
them to whomever you want. 

4.8.1 Record Sounds 

Insert one plug of the special audio cable supplied by the manufacturer to the audio input 

socket (socket with the symbol “ ”) of the PC, refer to figure 4-7. If the PC has no audio 

input socket, insert the plug into the microphone socket (socket with the symbol “  ”). 

Figure 4-7 The Audio Input Socket on the PC 

 

Turn on the PC; startup the sound recorder (Click “Start”→ “Programs” → “Accessories” → 
“Entertainment” → “Sound Recorder”). Refer to figure 4-8. 

 

 

 

 

Audio Input Socket 
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Figure 4-8 Startup the Sound Recorder 

 

Monitor the FHR with the method described in section 4.6. When the ideal signal is detected, 
unplug the earphone first if it’s connected; insert the other plug of the audio cable into the 
earphone socket on the Doppler.  

Figure 4-9 The Sound Recorder                   Figure 4-10 Recording 

      

Click Start  to start recording, refer to figure 4-9.  

You can record 60 seconds every time, when time is up, click Start again to keep on 
recording. 

Click Stop  to stop recording, refer to figure 4-10. 

Click “File” → “Save”, input the file name, select a folder and click Save.  

To start a new recording, click “File” → “New”. 
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4.8.2 Play Sound Files 

The recorded sounds are saved as a waveform (.wav) file in your computer. 

You can play the waveform file in Sound Recorder. Startup the Sound Recorder, click “File” 
→ “Open”, search for the folder and select the file, click Open to load the file, click Play 

. 

If you have any other program that supports waveform (.wav) files installed on your PC, 
double click the file to play it. 

4.8.3 Burn CD or Send in Email 

The waveform files saved in your PC are normal audio data files. You can burn them into 
CDs or e-mail to whomever you want. 

4.8.4 Record Troubleshooting 

If there is audio output from the speaker or earphone, but when recording starts, no sound is 
input. (The green line recording area has no waveform.) The reason could be: 

1. The plug of audio cable is not well connected to the Doppler or the PC socket.  

Re-connect the cable if this condition is detected. 

2. The plug of audio cable has been inserted to the wrong socket of the PC, instead of the 
audio input socket or the microphone socket.  

Insert the plug to the right socket if this condition is detected. 

3. The Line in or microphone is muted on PC.  

If this condition is detected, change the setting of the PC in these steps:  

  a) Double click the volume symbol on the right bottom corner; 

 

 

  b) The Volume Control menu pops up: 
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 Figure 4-11 Volume Control 

 
 

c) If the Line In or microphone volume control is not shown in the Volume Control menu, 
click “Options” → “Properties”, tick the Line In and Microphone as shown in figure 
4-12, click OK: 

   Figure 4-12 Properties 
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  d) Undo the tick of Line In and Microphone Mute, click  to exit. 

 
 

  e) Start a new recording. 

 

4.9 Vascular Monitoring (Optional)  

If the SONOTRAX Series Ultrasonic Pocket Dopplers are connected with 4MHz or 8MHz 
probes, they can be used to do vascular monitoring, which meets most arterial and venous 
assessment applications, including helping to detect arterial and venous disease, arterial and 
venous flow studies and other application where detection of blood flow is important. 

Choose appropriate probe as needed. The 8MHz probe has better resolution and wider 
detecting range than the 4MHz probe, but the 4MHz has a deeper detecting depth. 

Apply a liberal amount of gel on the site to be examined. Place the probe at 45º to the skin 
surface over the vessel to be examined. Adjust the position of the probe to obtain the loudest 
audio signal. Refer to figure 4-13 for the probe sites: 
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Figure 4-13 Probe sites 

 

For best results, keep the probe as still as possible once the optimum position has been found. 
Adjust the audio volume as required. High pitched pulsatile sounds are emitted from arteries 
while veins emit a non-pulsatile sound similar to a rushing wind. 

Vascular monitoring provides audio signals of arteries and veins. If it is done with 
SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, SONOTRAX II or 
SONOTRAX II Pro, the figure displayed on the LCD screen is null. 

Vertebral Artery (4.0MHz) 

Carotid Artery (4.0/8.0MHz)  Carotid Artery (4.0/8.0MHz) 

Subclavian Artery (4.0MHz) 

Subclavian Vein (4.0MHz) 

Jugular Vein (4.0MHz) 

Brachial Artery (8.0MHz) 

Ulner Artery (8.0MHz) 

Radial Artery (8.0MHz) 

Femoral Artery (4.0MHz)  

Femoral Vein (4.0MHz) 

Popliteal Artery (4.0MHz) 

Great Saphenous Vein (4.0/8.0MHz) 

Small Saphenous Vein (8.0MHz) Posterior Tibial Artery (8.0MHz) 

Dorsalis Pedis Artery (8.0MHz) 

Posterior Tibial Vein (8.0MHz) 
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4.10 Shut down the Doppler 

When the monitor is finished, wipe off the remaining gel off the probe with a clean soft cloth, 
then put the probe back into the probe frame. 

Press the POWER button on the SONOTRAX Lite again to shut it down. 

If there is no signal input or no operation done to SONOTRAX Basic, SONOTRAX Basic A, 
SONOTRAX Pro, SONOTRAX II and SONOTRAX II Pro for 60 seconds, it will 
automatically shut down. Or the users can press and hold the POWER button for 3 seconds to 
shut it down manually. 

4.11 Replacing or charging the battery 

When the Doppler gives out alarm indicating the battery power is low, you have to shut down 
the Doppler to replace or charge the battery. 

For SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A and SONOTRAX Pro 
Doppler, follow the reverse order of installing a battery described in section 4.2 to replace the 
battery. 

For SONOTRAX II and SONOTRAX II Pro Doppler, charge their lithium-ion polymer 
battery in the machine by inserting the DC plug of the special charger supplied by EDAN in 
to the charge socket on the Doppler and connecting the AC plug of it to the a.c.110-240V, 
50/60 Hz power supply. 

It takes about 4 hours to fully charge the battery. When charging, the LED of the charger is 
orange; when the battery is fully charged, the LED turns to green. 

CAUTION : Make sure the Doppler is shutdown before charging the battery or 
opening the battery compartment. 

 CAUTION : Only charge the lithium-ion polymer batter of SONOTRAX II and 
SONOTRAX II Pro in the machine. Do not use the Doppler for 
monitoring until the charger is disconnected with the Doppler. 



SONOTRAX Series Ultrasonic Pocket Doppler User Manual 

- 25 - 

Chapter 5 Product Specifications 

Product Name: Ultrasonic Pocket Doppler  
Model No.: SONOTRAX Lite, SONOTRAX Basic, SONOTRAX Basic A, SONOTRAX Pro, 

SONOTRAX II, SONOTRAX II Pro 

Safety: 

Complies with: EN 60601-1/1990 

Classification:  

Anti-electric Shock Type: Internally powered equipment 

Anti-electric Shock Degree: Type B equipment  
Degree of Protection against Harmful Ingress of Water:  

Main Unit: Non-protected  

2.0MHz Waterproof Probe, 3.0MHz Waterproof Probe, 4.0MHz Waterproof Vascular 
Probe, 8.0MHz Waterproof Vascular Probe: IPX8 Water Ingress Protection Code, which 
indicates this probe can work continuously for 5 hours when being immersed into water 
within 1 meter depth. 

Degree of Safety in Presence of Flammable Gases: Equipment not suitable for use in 
presence of flammable gases 

Working System: Continuous running equipment 

EMC: Group I Class B 

Physical Characteristic: 
Size: 32 (Depth) x 85 (Width) x 138 (Height) mm 

Weight: 290±5g (including a battery and a probe) 

Environment: 
  Working:          Temperature: +5°C ∼ +40°C 

      Humidity: ≤80% 
      Atmospheric Pressure: 860hPa ∼ 1060hPa 
 

Transport and Storage:    Temperature: -10°C ∼ + 55°C 
      Humidity: ≤93% 

    Atmospheric Pressure: 860hPa ∼1060hPa    

Display: 45*25mm LCD display 

FHR Performance: 
FHR Measuring Range: 50bpm ~ 210bpm  
Resolution: 1bpm 
Accuracy: ±3bpm 



SONOTRAX Series Ultrasonic Pocket Doppler User Manual 

- 26 - 

Recording and Playing: 
Audio Sampling Frequency: 4KHz / 8KHz 
Recording Length: 480s / 240s 
Recording can be played 

White Back Light: 
Two Brightness Adjustable: OFF, ON 

Audio Output Power: 0.5W 

Auto Shut down: 
After 1 minute no signal or no operation, auto shut down  

Battery Type Recommended:  

9 volt DC alkaline battery (IEC Type No. 6LR61/6LF22 or equivalent). 

Stand-by Time (hour): 

SONOTRAX Lite >10 hours 

SONOTRAX Basic >13 h 

SONOTRAX Basic A >8 h (with backlight), >13 h (without backlight) 

9V Alkaline 
Battery 

SONOTRAX Pro >8 h (with backlight), >13 h (without backlight) 

500mAh >8 h (with backlight), >13 h (without backlight) Lithium-ion 
Polymer 
Battery 900mAh >15 h (with backlight), >24 h (without backlight) 

Lithium-ion Polymer Battery 

Type: Lithium-ion Polymer Battery 

Nominal Capacity: ≥500mAh 

Nominal Voltage: 7.4V 

Charge Mode: Constant current / Constant voltage 

Charge Current (Standard): 300mA 

Charge Voltage (Standard): 8.4V 

-20°C ∼ 40°C (3 months) Storage Temperature: 

-20°C ∼ 60°C (1 month) 

Circle Life: ≥500 times 
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Ultrasound 

2.0MHz Waterproof Probe 2.0MHz 

3.0MHz Waterproof Probe 3.0MHz 

4.0MHz Waterproof Vascular 
Probe 4.0MHz 

Nominal Frequency 
 
 
 
 
 8.0MHz Waterproof Vascular 

Probe 8.0MHz 

2.0MHz Waterproof Probe 2.0MHz±10% 

3.0MHz Waterproof Probe 3.0MHz±10% 

4.0MHz Waterproof Vascular 
Probe 4.0MHz±10% 

Working Frequency  
 
 
 
 
 8.0MHz Waterproof Vascular 

Probe 8.0MHz±10% 

P－ < 1MPa 

Iob < 10 mW/cm2 

Ispta < 100mW/cm2 

Working Mode Continuous wave Doppler 

2.0MHz Waterproof Probe 245mm2±15% 

3.0MHz Waterproof Probe 245mm2±15% 

4.0MHz Waterproof Vascular 
Probe 32mm2±15% 

Effective Radiating Area 
of Transducer 
 
 
 
 8.0MHz Waterproof Vascular 

Probe 14mm2±15% 
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Chapter 6 Maintenance 

6.1 Maintenance 

The probe acoustic surface is frangible and must be handled with care.   

Gel must be wiped from the probe after use. These precautions will prolong the life of the 
unit. 

The user must check that the equipment does not have visible evidence of damage that may 
affect the pregnant woman’s safety or SONOTRAX Series capability before use. The 
recommended inspection interval is once per month or less. If damage is evident, replacement 
is recommended before use. 

The equipment should undergo periodic safety testing to insure proper personnel isolation 
from leakage currents. This should include leakage current measurement. The recommended 
testing interval is once every two years or as specified in the institution’s test and inspection 
protocol. 

The accuracy of FHR is controlled by the equipment and can not be adjusted by user. If the 
FHR result is distrustful, please use other method such as stethoscope to verify immediately 
or contact local distributor or manufacturer to get help. 

6.2 Cleaning 
Before cleaning, switch off the power and take out the batteries. 

Keep the exterior surface of the device clean and free of dust and dirt, clean exterior surface 
(display screen included) of the unit with a dry, soft cloth. If necessary, clean it with a soft 
cloth soaked in a solution of soap, or water and wipe dry with a clean cloth immediately. 

Wipe the probe with soft cloth to remove any remaining coupling gel. Clean with soap and 
water only. 

CAUTION : Don’t use strong solvent, for example, acetone. 

CAUTION : Never use an abrasive such as steel wool or metal polish. 

CAUTION : Do not allow any liquid to enter the product, and do not 
immerse any part of the device into any liquid. 

CAUTION : Avoid pouring liquids on the device while cleaning. 

CAUTION : Don’t remain any cleaning solution on the surface of the 
device. 

NOTE: Wipe the surface of probe with 70% ethanol or isopropranol alcohol, 
self-air dry, or clean with a clean, dry cloth.  
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6.3 Disinfection 

Clean the equipment exterior surface, probe, etc. as above. For the disinfecting of 2.0MHz 
waterproof probe/ 3.0MHz waterproof probe, immerse the probe into the solutions of 
Benzalkonium Bromide, 0.5% Chlorhexidine, 2% Glutaraldehyde or 75% ethanol to disinfect. 
Wipe the probe with a clean, dry cloth to remove any remaining moisture. 

NOTE: Please pay attention to the height when the probe is immersed in order 
to prevent the sterilant from entering the probe socket. 

CAUTION : Never try to sterilize the probe or equipment by low 
temperature steam or other methods.  



SONOTRAX Series Ultrasonic Pocket Doppler User Manual 

- 30 - 

Chapter 7 Warranty and Service 

Warranty 
EDAN warrants that each product we sell you is free from defects in labor and materials and 
shall conform to its product specifications as defined in the user documentation.  

EDAN provides a one-year-warranty for the products (accessories are included). The warranty 
period begins on the date the products are shipped to distributors. If the product doesn’t 
function as warranted during the warranty period, we will repair or replace it without charge. 

The product can not be repaired by users. All services must be done by the engineers 
approved by EDAN. Misuse, improper maintenance may void the warranty. 

After Service 

Upon request, EDAN can provide technical documentation or schematic diagram to the 
qualified engineer approved by EDAN. If you require, please contact us. 

For service any question regarding this device, please contact EDAN or your local distributor. 
Get service details from EDAN website: http://www.edan.com.cn. 

Manufacturer: Edan Instruments, Inc. 

Address: 3/F-B, Nanshan Medical Equipments Park, Nanhai Rd 1019#, Shekou, Nanshan 
Shenzhen, 518067 P.R. CHINA 

TEL: +86-755-26898321, 26899221 

FAX: +86-755-26882223, 26898330 

E-Mail: support@edan.com.cn 

http://www.edan.com.cn
mailto:support@edan.com.cn
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Appendix A EMC Information-Guidance and 
Manufacture’s Declaration 

A1.1 Electromagnetic Emissions - for all Equipment and 
Systems 

Guidance and manufacture’s declaration–electromagnetic emission 

The SONOTRAX Series Ultrasonic Pocket Doppler is intended for use in the electromagnetic 
environment specified below. The customer or the user of the device should assure that it is used in such 
an environment. 

Emission test Compliance Electromagnetic environment–guidance 

RF emissions 
CISPR 11 Group 1 

The SONOTRAX Series Ultrasonic Pocket Doppler uses RF 
energy only for its internal function. Therefore, its RF emissions 
are very low and are not likely to cause any interference in nearby 
electronic equipment. 

RF emission 
CISPR 11 Class B 

The SONOTRAX Series Ultrasonic Pocket Doppler is suitable 
for use in all establishments, including domestic establishments 
and those directly connected to the public low-voltage power 
supply network that supplies buildings used for domestic 
purposes. 

 

A1.2 Electromagnetic Immunity - for all Equipment and 
Systems 

Guidance and manufacture’s declaration–electromagnetic immunity 

The SONOTRAX Series Ultrasonic Pocket Doppler is intended for use in the electromagnetic 
environment specified below. The customer or the user of the device should assure that it is used in such 
an environment. 

Immunity test IEC 60601 test 
level Compliance level Electromagnetic 

environment-guidance 

Electrostatic 
discharge (ESD) 
IEC 61000-4-2 

±6 kV contact 
±8 kV air 

±6 kV contact 
±8 kV air 

Floors should be wood, 
concrete or ceramic tile. If 
floor are covered with 
synthetic material, the relative 
humidity should be at least 
30%. 
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A1.3 Electromagnetic Immunity - for all Equipment and 
Systems that are not Life-supporting 

Guidance and manufacture’s declaration – electromagnetic immunity 

The SONOTRAX Series Ultrasonic Pocket Doppler is intended for use in the electromagnetic 
environment specified below. The customer or the user of the device should assure that it is used in such 
an environment. 

Immunity test IEC 60601 test level Compliance 
level Electromagnetic environment-guidance 

 
 
 
 
 
 
 
 
 
Radiated RF 
IEC 61000-4-3 
 
 

 
 
 
 
 
 
 
 
 
3 V/m 
80 MHz to 2.5 GHz 
 

 
 
 
 
 
 
 
 
 
 
3 V/m 

Portable and mobile RF communications 
equipment should be used no closer to any 
part of the SONOTRAX Series Ultrasonic 
Pocket Doppler, including cables, than the 
recommended separation distance 
calculated from the equation applicable to 
the frequency of the transmitter. 
Recommended separation distance 

P
E

d 







=

1

5.3
 80 MHz to 800 MHz 

P
E

d 







=

1

7
 800 MHz to 2.5 GHz 

Where P is the maximum output power 
rating of the transmitter in watts (W) 
according to the transmitter manufacturer 
and d is the recommended separation 
distance in metres (m). 
Field strengths from fixed RF transmitters, 
as determined by an electromagnetic site 
survey,a should be less than the 
compliance level in each frequency 
range.b 
Interference may occur in the vicinity of 
equipment marked with the following 
symbol: 

 

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies. 
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by 
absorption and reflection from structures, objects and people. 

a Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones 
and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be 
predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF 
transmitters, an electromagnetic site survey should be considered. If the measured field strength in 
the location in which the SONOTRAX Series Ultrasonic Pocket Doppler is used exceeds the 
applicable RF compliance level above, the SONOTRAX Series Ultrasonic Pocket Doppler should be 
observed to verify normal operation. If abnormal performance is observed, additional measures may 
be necessary, such as reorienting or relocating the SONOTRAX Series Ultrasonic Pocket Doppler. 

b    Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m. 
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A1.4 Recommended Separation Distances 

Recommended separation distances between portable and mobile RF communications equipment 
and the SONOTRAX Series Ultrasonic Pocket Doppler 

The SONOTRAX Series Ultrasonic Pocket Doppler is intended for use in an electromagnetic environment 
in which radiated RF disturbances are controlled. The customer or the user of the device can help prevent 
electromagnetic interference by maintaining a minimum distance between portable and mobile RF 
communications equipment (transmitters) and the SONOTRAX Series Ultrasonic Pocket Doppler as 
recommended below, according to the maximum output power of the communications equipment. 

Separation distance according to frequency of transmitter 
(m) 

 
Rated maximum 
output power of 

transmitter 
(W) 

80 MHz to 800 MHz 

P
E

d 







=

1

5.3
 

800 MHz to 2.5 GHz 

P
E

d 







=

1

7
 

0.01 0.1167 0.2334 

0.1 0.3689 0.7378 

1 1.1667 2.3334 

10 3.6893 7.3786 

100 11.6667 23.3334 

For transmitters rated at a maximum output power not listed above, the recommended separation distances 
in metres (m) can be estimated using the equation applicable to the frequency of the transmitter, where P 
is the maximum output power rating of the transmitter in watts (W) according to the transmitter 
manufacturer. 
 
NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies. 
NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by 
absorption and reflection from structures, objects and people. 
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Appendix 2 Overall Sensitivity 
Overall Sensitivity (2MHz Probe) 

Two-way Attenuation 
B=∑Ba+Bw Diameter of Target 

Reflector 
(mm) 

Distance 
(d) 

(mm) 

Reflection Loss A(d) 

∑Ba 
(T:mm   Ba:dB) 

Bw 
(dB) 

B 
(dB) 

Vs (r.m.s.) 
mV 

Vn (r.m.s) 
mV 

( )
( )








=

...

...log20 10 smrV
smrVC

n

s
 

dB 

Overall Sensitivity 
(S=A(d)+B+C) 

dB 

T 20 4.8 4.0 - 
50 45.7 

Ba 40 9.6 8.0 - 
0 57.6 186 94 5.93 109.2 

T 20 4.8 3.4 - 
75 45.7 

Ba 40 9.6 6.8 - 
0 56.4 175 90 5.78 107.8 

T 20 4.8 3.4 - 
100 45.7 

Ba 40 9.6 6.8 - 
0 56.4 174 89 5.82 107.9 

T 20 4.8 - - 

1.58 
A=45.7dB@ 

2MHz 

200 45.7 
Ba 40 9.6 - - 

0 49.6 173 90 5.68 100.9 

T 20 4.8 3.4 2.2 
50 43.2 

Ba 40 9.6 6.8 4.4 
0 60.8 178 89 6.02 110.0 

T 20 4.8 3.4 1 
75 43.2 

Ba 40 9.6 6.8 2 
0 58.4 170 90 5.52 107.1 

T 20 4.8 3.4 - 
100 43.2 

Ba 40 9.6 6.8 - 
0 56.4 165 85 5.76 105.3 

T 20 4.8 1 - 

2.38 
A=43.2dB@ 

2MHz 

200 43.2 
Ba 40 9.6 2 - 

0 51.6 160 85 5.49 100.2 

Doppler Frequency (Hz) 333 Velocity of Target (cm/s) 12.5 
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Overall Sensitivity (3.0 MHz Probe) 

Two-way Attenuation 
B=∑Ba+Bw Diameter of 

Target 
Reflector 

(mm) 

Distance 
(d) 

(mm) 

Reflection 
Loss A(d) 

(dB) ∑Ba 

(T:mm   Ba:dB) 
Bw 

(dB) 
B 

(dB) 

Vs (r.m.s.) 
mV 

Vn (r.m.s) 
mV 

( )
( )








=

...

...log20 10 smrV
smrVC

n

s
 

dB 

Overall 
Sensitivity 

(S=A(d)+B+C) 
dB 

T 10 4 - - 
50  

Ba 43.6 17.9 - - 
0 61.5 179 90 5.97 111.9 

T 10 3 - - 
75  

Ba 43.6 13.5 - - 
0 57.2 186 94 5.93 107.63 

T 10 3 - - 
100  

Ba 43.6 13.5 - - 
0 57.2 173 88 5.87 107.5 

T 10 1 - - 

1.58 
A=44.5dB@ 
3MHz 

200  
Ba 43.6 6.5 - - 

0 50.2 171 89 5.67 100.3 

T 10 4 - - 
50  

Ba 43.6 17.9 - - 
0 61.5 194 88 6.73 110.2 

T 10 3 - - 
75  

Ba 43.6 13.5 - - 
0 57.2 172 87 5.92 105.1 

T 10 2 - - 
100  

Ba 43.6 9.6 - - 
0 53.2 165 85 5.76 100.9 

T 10 1 - - 

2.38 
A=42.0dB@ 
3MHz 

200  
Ba 43.6 6.5 - - 

0 50.2 160 84 5.59 97.8 

Doppler Frequency (Hz) 500 Velocity of Target (cm/s) 12.5 
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